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Introduction 

Infor Care Workloads Utilities is a windows forms based application that contains a set of tools to 

perform maintenance tasks on the Infor Care Workloads Database as well as create a “Sanitized” 

database for Infor Care Workloads Technical Support. 



Using the Infor Care Workloads Utilities 
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Using the Infor Care Workloads Utilities 

Menu Bar 
The Menu Bar at the top of the application provides the primary source of the application’s 

functionality. 

View Menu 

On the “View” Menu you can change the “Font Size”. You can also choose which “Toolbars” are 

displayed. 

Other options include display of the “Status Bar”, the ability to “Reset” the “View” settings to the 

default values, and “Refresh”. 

Tools Menu 

The “Tools” Menu provides access to all of the application’s functions. Each item in the “Tools” Menu 

will be reviewed in detail in the Tools section. 

Windows Menu 

The “Windows” Menu provides access to open windows within the application. 
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Setting Database Context 

Before selecting a Server & Database determine what method of authentication will work best. In 

most cases Windows Authentication will be the most suitable. However, some Database 

Administrators choose to prevent Windows Authentication or may not allow access for your user. 

In those cases choose SQL Server Authentication and enter the User Name and Password 

provided by your DBA 

Click the drop-down arrow to the right of the Server (top drop down) to display a list of available 

servers. If the desired Server is not listed you may manually type the Server’s name in the drop-

down box. 

The list of available Infor Care Workloads databases on the selected Server will now be 

automatically populated. Click the drop-down arrow to the right of the Database (bottom drop down) 

to display a list of available Infor Care Workloads databases 

If the desired Database is not listed you may manually type the Database’s name in the drop-down 

box. However, with regards to the Database selection, it is recommended to pick from the drop-down 

list to prevent possible errors. 

Now that a valid Server & Database have been selected, the Tools menu may be used to perform 

actions using these selections. 
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Tools 

Database Utilities 
The Database Utilities can be used to perform various actions on the selected database. 

Sanitize 
The Sanitize Database Utility will copy the selected database, remove Patient Information, and 

upload the database to the Infor Care Workloads Technical Support server. This is often necessary 

to allow the Infor Care Workloads Technical Support team to debug issues that the facility is 

experiencing. Start by selecting the appropriate Sanitize Type: 

  

Normal Selecting this option will remove Patient & Employee Names from the Infor 

Care Workloads database as well as from all HL7 Messages. The ADT, 

Archive, Audit, & Error Logs will also be truncated. This option should be 

selected if the database is requested in order to debug an HL7 Issue. 

Remove 

Hospital 

Patient Identifiers 

Selecting this option will remove Patient & Employee Names plus Patient, 

Encounter, and Visit Identifiers from the Infor Care Workloads database. All 

ADT, Archive, Audit, Error, & HL7 Logs will also be truncated. This option 

should not be selected if the database has been requested to debug an HL7 

issue. 

Remove 

Collected 

Data 

Selecting this option will remove all data from the Infor Care Workloads 

database leaving just the setup of Unit, Instruments, etc. This option should 

be selected when the Infor Consultant requests the database for use during 

the refinement process. 

 

Next, select the appropriate Additional Parameters: 

 The Truncate Log File option will Truncate the Log File of the Sanitized Database to reduce the 

size of the file being uploaded. This will not Truncate the Log file of the selected database. 
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 The Automatically Upload Database option will copy the Sanitized Database to the Infor Care 

Workloads Technical Support server with no user intervention. 

 The Delete File after Upload option will remove the local copy of the Sanitized Database after 

the upload to the Infor Care Workloads Technical Support server is completed. 

The Sanitize process must be executed on the database server because of file manipulation 

operations. If attempted remotely an alert window will be displayed. 

The sanitization process will produce a minimum of two (2) .gzip files that are exclusively compatible 

with this application. These files are not only divided and compressed but also encrypted using a 

Symmetric Rijndael Managed encryption algorithm. To reassemble these files into the original file 

you MUST use the Decompress Backup File(s) File Utility of Infor Care Workloads Utilities. The 

compressed file names should not be changed to ensure proper decompression. 

Maintain 
The “Maintain” Menu of “Database Utilities” contains several functions that are typically performed 

on a routine basis to keep the database optimized. These functions are normally part of a scheduled 

SQL Server Maintenance Plan and should not need to be executed from Infor Care Workloads 

Utilities. Each function will require you to enter a Confirmation Code prior to execution. 

Defragment 

The “Defragment” function will execute the command: 

 _DBA_Reindex 2 

to perform a Defragmentation on each table in the Infor Care Workloads Database. 

Reindex 

The “Reindex” function will execute the command: 

 _DBA_Reindex 1 

to perform a Reindex of each table in the Infor Care Workloads Database. 

Repair 

The “Repair” function will execute the commands: 

Alter Database [DATABASENAME] Set Single_User With Rollback Immediate 
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DBCC CheckDB (' DATABASENAME ', Repair_Rebuild) 

Alter Database [DATABASENAME] Set Multi_User With Rollback Immediate 

to attempt to perform a Repair of the Infor Care Workloads Database. 

Shrink 

The “Shrink” function will execute the command: 

DBCC ShrinkDatabase (' DATABASENAME ', 10) 

to attempt to Shrink the Infor Care Workloads Database. 

Truncate Log 

The “Truncate Log” function will execute the command: 

DBCC ShrinkFile (' DATABASENAME _Log', TruncateOnly) 

to Truncate the log for the Infor Care Workloads Database 

Delete Records 
The “Delete Records” functions allow you to permanently remove records from the database. Each 

function will require you to enter a Confirmation Code prior to execution. 

Budget(s) 

The “Delete” “Budgets” function allows you to remove old, outdated, or mistakenly added Budgets 

from the database. 

Each Budget is listed with its Unit, Unit Standard Set Dates, and Budget Dates to help identify the 

exact Budget to be deleted. 100 records will be displayed at a time. If more than 100 Budgets exist 

use the “First”, “Previous”, “Next”, and “Last” buttons to navigate the Budgets. 

Instrument(s) 

The “Delete” “Instrument(s)” function allows you to remove old, outdated, or mistakenly added 

Instruments from the database. 
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Each Instrument is listed with its Standard Set dates allowing you to delete an entire Instrument or a 

Standard Set for an Instrument. 100 records will be displayed at a time. If more than 100 Instruments 

exist use the “First”, “Previous”, “Next”, and “Last” buttons to navigate the Instruments. 

Unit(s) 

The “Delete” “Units” function allows you to remove old, outdated, or mistakenly added Units from the 

database. 

Each Unit is listed with its Standard Set dates allowing you to delete an entire Unit or a Standard Set 

for a Unit. 100 records will be displayed at a time. If more than 100 Units exist use the “First”, 

“Previous”, “Next”, and “Last” buttons to navigate the Units. 

Patient(s) 

The “Delete” “Patient(s)” function allows you to completely remove records for selected Patients. 

This function may be used in a situation such as when copying the Production database to a Test or 

Training environment where it is desired to not have real Patient Information. 1,000 records will be 

displayed at a time. If more than 1,000 Patients exist use the “First”, “Previous”, “Next”, and “Last” 

buttons to navigate the Patients. 

Staffing 

The “Delete” “Staffing” function allows you to delete data presented on the Staffing screen of   . 

Select the Unit(s) that you want to remove data for and also the Date Range. 100 records will be 

displayed at a time. If more than 100 Units exist use the “First”, “Previous”, “Next”, and “Last” buttons 

to navigate the Units. If both Date values are unchecked then all Staffing will be deleted. If just the 

"Start Date" is selected then all Staffing after that Date will be deleted. If just the "Stop Date" is 

selected then all Staffing before that Date will be deleted. 

HL7 Log(s) 

The “Delete” “HL7 Log(s)” function allows you to clear the HL7 Audit and Failed Message Logs. 

This function may be used in a situation such as when copying the Production database to a Test 

environment where a unique Test HL7 data stream will be connected. 
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User(s) 

The “Delete” “User(s)” function allows you to completely remove Users. This will delete the User 

even if data is collected referencing this user. This data will be modified to reference the System 

Administrator. 

This function may be used in a situation such as when copying the Production database to a Test or 

Training environment where it is desired to not have real User Information. 1,000 records will be 

displayed at a time. If more than 1,000 Users exist use the “First”, “Previous”, “Next”, and “Last” 

buttons to navigate the Users. 
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File Utilities 

The “File Utilities” can be used to perform various actions on Infor Care Workloads files. 

Compression 
The “Compression” “File Utilities” can be used to compress and decompress database files. The 

compression process will divide the database file into at least two compressed files. In order to 

decompress the database file the user MUST use the “Decompress Backup File(s)” function within 

this application. If this Tool is not used the database file will not be reassembled properly and will not 

be useable. 

Compress Backup File 

The “Compress Backup File” “File Utility” will compress a database backup file into no less than two 

.gzip files.  

This process will produce a minimum of two (2) .gzip files that are exclusively compatible with this 

application. These files are not only divided and compressed but also encrypted using a Symmetric 

Rijndael Managed encryption algorithm. To reassemble these files into the original file you MUST 

use the “Decompress Backup File(s)” “File Utility” of Infor Care Workloads Utilities. The compressed 

file names should not be changed to ensure proper decompression. 

Decompress Backup File(s) 

The “Decompress Backup File(s)” “File Utility” will decompress a set of compressed database 

backup files. 

The compressed file names should not be changed to ensure proper decompression. This function 

will reassemble the compressed files into the original file that was compressed by Infor Care 

Workloads Utilities. 
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Remote File Manager 
The “Remote File Manager” can be used to retrieve a list of files on the Infor Care Workloads 

Technical Support Server. These files can then be downloaded, renamed, or deleted from the 

server. This same functionality is available on the Infor Care Workloads Technical Support web site, 

http://support.graspinc.com/FileManager/. Infor recommends using the Infor Care Workloads Utilities 

for large file manipulation as it has been designed to bypass some limitations presented in web-

based applications. 

When the “Remote File Manager” is opened the Organization of your User will be listed. The initial 

list of files will be Private Files, those files that are only available to your Organization and Infor 

Care Workloads Technical Support. 

 To change the name of a file, select the file and then either right-click and select “Rename”, click 

the “Rename File” button at the bottom of the screen, or click the file name a second time. Hit the 

“Enter” key to commit the change to the File Name. 

 To download a file, select the file and then either right-click and select “Download” or click the 

“Download File” button at the bottom of the screen. 

 To delete a file, select the file and then either right-click and select “Delete” or click the “Delete 

File” button at the bottom of the screen. 

 To upload a file click the “Upload File(s)” button at the bottom of the screen. This will open the 

“Upload File(s)” window. Please refer to Section 5.2.3 for information on this function. 

 To view Common Files available to all Infor Care Workloads users select “Common Files” from 

the File Type drop-down. This will display a list of files including all current installation files, 

Hotfix files, Guides, etc. You may not rename, delete, or upload files to the Common Files. You 

may only download these files. 

 

Upload File(s) 
The “Upload File(s)” “File Utility” allows you to upload files to the Private Files directory for your 

Organization on the Infor Care Workloads Technical Support server. Select the file(s) that you want 

to upload and then click “OK” to upload those files. 

http://support.graspinc.com/FileManager/


Disable Login / Force Logout 

Infor Care Workloads Utilities Guide  | 15 

Disable Login / Force Logout 

The “Disable Login / Force Logout” tool will present a description of the action to be performed and 

request that you enter a confirmation code before continuing. When the Confirmation Code is 

entered correctly the text will be green and the “OK” button will be enabled. When the process is 

completed an informational window will be displayed saying ‘Change to “Disable Login / Force 

Logout” status complete!’. 

When the login process on the database is disabled the icon and text for this Menu Item will change. 

A red X will appear over the login icon. To re-enable login for the selected database click “Enable 

Login”, enter the Confirmation Code, and click “OK”. 
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Update Remote Server Information 

The “Update Remote Server Information” screen is used to enter your credentials for the Infor Care 

Workloads Technical Support server. These credentials are provided by Infor and are the same as 

those used to login to https://www.inforxtremem.com. 

The default & recommended protocol is “HTTPS”. This will utilize the Infor Care Workloads 

Technical Support site as the remote file repository. However, some networks prevent Infor Care 

Workloads Utilities from connecting via HTTPS. If the HTTPS connection cannot be made, select 

“FTP”. Separate credentials will have to be provided by Infor and the files will not be accessible via 

the Infor Care Workloads Technical Support site. 

Select the Overwrite Existing Files option if you wish to allow new uploads to overwrite pre-existing 

files. 

Click the Test button to verify the login credentials and test the upload process. 

https://www.inforxtremem.com/
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